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1 Introduction 

SpiraTeam® is an integrated Application 

Lifecycle Management (ALM) system that 

manages your project's requirements, releases, 

test cases, issues and tasks in one unified 

environment: 

SpiraTeam® contains all of the features 

provided by SpiraTest® - our highly acclaimed 

test management system and SpiraPlan® - our 

agile project management solution. With 

integrated customizable dashboards of key 

project information, SpiraTeam® allows you to 

take control of your entire project lifecycle and 

synchronize the hitherto separate worlds of 

development and testing. 

This guide outlines how to migrate data to/from 

other tools into SpiraTeam. For information on 

integrating with other bug/issue tracking 

systems, please refer to the separate 

SpiraTeam External Bug-Tracking Integration 

Guide. For information on integrating SpiraTeam 

with third-party requirements management tools, 

please refer to the separate SpiraTeam 

Requirements Management Integration Guide. 

This guide assumes that the reader is familiar 

with both SpiraTeam and the appropriate tool 

being discussed. For information regarding how 

to use SpiraTeam, please refer to the 

SpiraTeam User Manual. 

Each of the sections covers a different tool so 

we recommend using the table of contents on 

the left to locate the tool you’re looking to either 

integrate or migrate from, then read the 

installation and usage instructions.
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2 Importing from Microsoft Excel 

The web-based interface of SpiraTeam® is ideal for creating and managing requirements, test cases and 

incidents for a new project. However when migrating requirements, test cases, test steps and incidents 

for an existing project from another system or Microsoft Office document (e.g. Excel), it is useful to be 

able to load in a batch of artifacts, rather than having to manually enter them one at a time. 

To simplify this task, SpiraTeam® comes with a Microsoft Excel Add-In that can export requirements, test 

cases, test steps and incidents from a populated Excel sheet into SpiraTeam®. In addition, the Add-In 

allows you to import those same artifacts back into the Excel sheet to make batch updates which can 

then be used to update the master copies on the server. 

Note that this guide refers to SpiraTeam®, but the Excel Add-In can be used with SpiraTest® and 

SpiraPlan® as well. The only difference is that some of the artifact types may not be available in 

SpiraPlan/Test. 

2.1 Installing the Microsoft Excel Add-In 

The first thing you need to do is to go to the “Add-Ons and Downloads” page of the Inflectra Website (it 

can be found in the SpiraTest, SpiraPlan or SpiraTeam sections), and download the MS-Office Add-Ins 

installation package. There are separate packages for the following versions of MS Office: 

 MS-Office 2003 Add-Ins – these are compatible with Microsoft Office 2003 and 2007. They can 

connect to SpiraTeam v2.3 or later. They also require Microsoft .NET 3.5. 

 MS-Office 2007 Add-Ins – these are compatible with Microsoft Office 2007 and 2010. They can 

connect to SpiraTeam v3.0 or later. They also require Microsoft .NET 4.0. 

 MS-Office 2010 Add-Ins – these are compatible with Microsoft Office 2010 and later. They can 

connect to SpiraTeam v5.0 or later. They also require Microsoft .NET 4.0. 

This installation package will install the add-ins for Microsoft Excel, Word and Project at the same time. If 

you don’t have the correct version of Microsoft .NET installed or some of the necessary prerequisites, you 

will be given the opportunity to install them when you first run the installation package. 

Once you have the Excel Add-In installed, the second thing you’ll need to download is the 

SpiraImportTemplate Excel Sheet. This spreadsheet contains the necessary pre-formatted columns that 

are needed for the Add-In to easily recognize the data and know how to handle it. There are three 

versions of the template available - SpiraImportTemplate.xls for the Excel 2003 Add-In, 

SpiraImportTemplate.xlsx for the Excel 2007 Add-In and SpiraImportTemplate2010.xslx for the Excel 

2010 Add-In. 

Once you have downloaded the template, please double-click on it to open it up in MS-Excel. You will 

notice that there is an additional toolbar displayed in Excel which is used for importing/exporting data 

to/from SpiraTeam: 

 

If you are using the MS-Excel 2007 or 2010 Add-In, you will see a modified version of the toolbar that 

makes use of the MS-Office Ribbon: 
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This toolbar allows you to connect to SpiraTeam, and perform the import/export. The process for using 

this toolbar is described below: 

2.2 Connecting to SpiraTeam® 

The first thing you need to do is to click on the [Connect] button to specify the information used to connect 

to your instance of SpiraTeam: 

 

Please enter the following information into the dialog box: 

o Spira URL: Please enter the web address that you use to access SpiraTeam® in your browser. This 

is usually of the form http://<hostname>/SpiraTeam. Make sure that you remove any suffixes 

from the address (e.g. Default.aspx). 

o User Name: Please enter the username that you use for logging in to SpiraTeam 

o Password: Please enter the password that you use for logging in to SpiraTeam 

o Remember Password: If you are using this Add-In on a private computer, you can check this option 

to have the system remember your credentials locally. Please do not use this option on a public 

computer and it will compromise the security of your SpiraTeam installation. 

Once you have entered the necessary information, please click [Connect] to authenticate with the server. 

If the login information is invalid, you will see an error message appear, otherwise you will be connected 

and the list of projects and artifacts will be populated. If you want to end your session, you should just 

click the [Disconnect] button and the Add-In will close your connection. 

2.3 Choosing the Project and Artifact 

Once you have successfully connected to SpiraTeam, you should now choose the appropriate Project 

and Artifact in the system that you will be importing / exporting: 

 

Or 
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The artifact choice will match the name of the Excel sheet in the template, so if you are going to be 

importing/exporting Requirements, you should choose “Requirements” from the dropdown list and then 

click on the “Requirements” tab inside the Excel import template. 

Once you have selected the project and artifact, there are three buttons that you can now use: 

o Import: Clicking this button will retrieve the data from the SpiraTeam server and use that to populate 

the spreadsheet. 

o Export: Clicking this button will take the data in the spreadsheet and use it to add/update items in 

SpiraTeam. 

o Clear: This button allows you to quickly clear the data in the import template while leaving all the 

necessary headings and other information that the Add-In needs to be able to import/export data. 

o Options: (Only in MS-Excel 2007/2010 Add-Inx). This button allows you to change some of the 

import/export options. 

2.4 Importing / Exporting Data 

The Excel Add-In is capable of either importing data from SpiraTeam into the Excel template or exporting 

data from the Excel template to SpiraTeam. However it is important to understand how the system knows 

whether to add new items to SpiraTeam or whether to update existing items: 

o If you start with a blank import spreadsheet and enter items into it, they will not have a value set on 

their ID column in the spreadsheet (this is always the first column in each sheet). When you perform 

an Export, it will add these as new items in SpiraTeam 

o If you start with a blank import spreadsheet and choose to Import data from SpiraTeam, those rows 

will include the ID of the item in the first column of the spreadsheet. You can either update those rows 

or add new rows in between. Any rows that have the ID column populated will be updated in 

SpiraTeam when you choose Export, whereas any newly added rows will be inserted in SpiraTeam. 

2.4.1 Importing/Exporting Releases 

To import/export releases, first you need to click on the “Releases” tab in the Excel sheet: 

 

Next if you want to import the list of existing Releases from SpiraTeam, you should click on the [Clear] 

icon to first remove the sample information from the spreadsheet, then click [Import] to load the list of 

existing releases into the sheet. These items will all have the “Rel #” column populated so that the system 

knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of releases from a spreadsheet, then you need to either enter the 

releases into this specially formatted spreadsheet or cut and paste them in from another existing Excel 

sheet that you’ve been using to manage releases previously. Then click [Export] and the new items will 

be added to your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 
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Field name Description 

Rel # Stores the ID of the release. Should be left blank for new items being 

added to SpiraTeam 

Release Name The name of the release. This field supports indentation, so you need 

to use Excel’s ability to Indent text fields to indicate how the items in 

the release hierarchy are organized 

Release Description The long description of the release. If you want it formatted, you need 

to add HTML tags such as <b> for bold 

Version Number The version number for the release; acts as the short name 

Active Whether this release is active or not. Should be set to either Y/N 

Iteration Whether this release is an Iteration or not. Should be set to either Y/N 

Creator The user that should listed as the release’s creator. Needs to be the ID 

of the user (e.g. user US00005 would be entered as just 5) 

Start Date The date that work on the release is scheduled to start 

End Date The date that work on the release is scheduled to end 

# Resources The number of people / resources that are scheduled to work on the 

release. 

Non-Wk Days The number of non-working days that should be subtracted from the # 

available hours for work performed on the release. 

MS-Excel 2003/2007 Add-In Specific Fields 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

MS-Excel 2010 Add-In Specific Fields 

Status The status of the release. It needs to be one of the values from the 

dropdown list 

Type The type of the release (major, minor, iteration or phase). It needs to 

be one of the values from the dropdown list 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value entered 

depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 

• MultiList – provide a comma-separated list of the numeric IDs 

of the custom list values (e.g. PV00005 and PV00003 would 

be entered as just “5,3”) 

• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format (e.g. 

m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

Comment The description of a comment that should be appended to the item. If 

you want it formatted, you need to add HTML tags such as <b> for 

bold. Note that this field always appends, so if you want to add two 
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comments, just enter the first value and click [Export], then replace it 

with the second value and click [Export] 

 

Note: the columns that are required are listed in bold type. 

2.4.2 Importing/Exporting Requirements 

To import/export requirements, first you need to click on the “Requirements” tab in the Excel sheet: 

 

Next if you want to import the list of existing Requirements from SpiraTeam, you should click on the 

[Clear] icon to first remove the sample information from the spreadsheet, then click [Import] to load the list 

of existing requirements into the sheet. These items will all have the “Req #” column populated so that the 

system knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of requirements from a spreadsheet, then you need to either enter the 

requirements into this specially formatted spreadsheet or cut and paste them in from another existing 

Excel sheet that you’ve been using to manage requirements previously. Then click [Export] and the new 

items will be added to your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 

Req # Stores the ID of the requirement. Should be left blank for new items 

being added to SpiraTeam 

Requirement Name The name of the requirement. This field supports indentation, so 

you need to use Excel’s ability to Indent text fields to indicate how 

the items in the requirement hierarchy are organized 

Requirement Description The long description of the requirement. If you want it formatted, 

you need to add HTML tags such as <b> for bold 

Importance The importance / priority of the requirement. It needs to be one of 

the values from the dropdown list. 

Status The status of the requirement. It needs to be one of the values from 

the dropdown list. If this is not specified, the requirement will default 

to the “Requested” status. 

Author The user that should listed as the requirement’s author. Needs to 

be the ID of the user (e.g. user US00005 would be entered as just 

5) 

Owner The user that should listed as the requirement’s owner. Needs to be 

the ID of the user (e.g. user US00005 would be entered as just 5) 

MS-Excel 2003/2007 Add-In Specific Fields 

Release # The release that this requirement is scheduled for. Needs to be the ID 

of the release (e.g. release RL00005 would be entered as just 5) 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 
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MS-Excel 2010 Add-In Specific Fields 

Release Version The release/iteration that this requirement is scheduled for. Needs to 

be the version number of the release (e.g. 1.0.1.1) 

Type The type of the requirement. It needs to be one of the values from the 

dropdown list. 

Estimate The estimate (in points) of the requirement. It should be a decimal 

number with one decimal place (e.g. 1.0, 2.5, etc.) 

Component This should be the Name of the Component the requirement is 

assigned-to. E.g. "Component 1" 

Linked Requirements Comma-separated list of requirement IDs (without the RQ prefix) that 

this requirement should be linked to (e.g. 204, 891) 

Note: This field only Exports to Spira and not the other way around 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value entered 

depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 

• MultiList – provide a comma-separated list of the numeric IDs 

of the custom list values (e.g. PV00005 and PV00003 would 

be entered as just “5,3”) 

• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format (e.g. 

m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

Comment The description of a comment that should be appended to the item. If 

you want it formatted, you need to add HTML tags such as <b> for 

bold. Note that this field always appends, so if you want to add two 

comments, just enter the first value and click [Export], then replace it 

with the second value and click [Export] 

 

Note: the columns that are required are listed in bold type. 

2.4.3 Importing/Exporting Test Sets 

To import/export test sets, first you need to click on the “Test Sets” tab in the Excel sheet: 

 

Next if you want to import the list of existing Test Sets from SpiraTeam, you should click on the [Clear] 

icon to first remove the sample information from the spreadsheet, then click [Import] to load the list of 

existing test sets into the sheet. These items will all have the “TX #” column populated so that the system 

knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of test sets from a spreadsheet, then you need to either enter the test 

sets into this specially formatted spreadsheet or cut and paste them in from another existing Excel sheet 
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that you’ve been using to manage test sets previously. Then click [Export] and the new items will be 

added to your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 

TX # Stores the ID of the test set. Should be left blank for new items 

being added to SpiraTeam 

Test Set Name The name of the test set. This field supports indentation, so you 

need to use Excel’s ability to Indent text fields to indicate how the 

items in the test set hierarchy are organized 

Test Set Description The long description of the test set. If you want it formatted, you 

need to add HTML tags such as <b> for bold 

Folder Whether this item is a folder or not. Should be set to either Y/N 

Status The status of the test set. It needs to be one of the values from the 

dropdown list. 

Creator The user that should listed as the test set’s creator. Needs to be the 

ID of the user (e.g. user US00005 would be entered as just 5) 

Owner The user that should listed as the test set’s owner. Needs to be the 

ID of the user (e.g. user US00005 would be entered as just 5) 

Planned Date The date that the test set needs to be completed by. 

MS-Excel 2003/2007 Add-In Specific Fields 

Release # The release that this test set is scheduled for. Needs to be the ID of 

the release (e.g. release RL00005 would be entered as just 5) 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

MS-Excel 2010 Add-In Specific Fields 

Release Version The release/iteration that this test set is scheduled for. Needs to be the 

version number of the release (e.g. 1.0.1.1) 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value entered 

depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 

• MultiList – provide a comma-separated list of the numeric IDs 

of the custom list values (e.g. PV00005 and PV00003 would 

be entered as just “5,3”) 

• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format (e.g. 

m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

Comment The description of a comment that should be appended to the item. If 

you want it formatted, you need to add HTML tags such as <b> for 

bold. Note that this field always appends, so if you want to add two 

comments, just enter the first value and click [Export], then replace it 

with the second value and click [Export] 
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Note: the columns that are required are listed in bold type. 

2.4.4 Importing/Exporting Test Cases 

To import/export test cases, first you need to click on the “Test Cases” tab in the Excel sheet: 

 

Next if you want to import the list of existing Test Cases from SpiraTeam, you should click on the [Clear] 

icon to first remove the sample information from the spreadsheet, then click [Import] to load the list of 

existing test cases into the sheet. These items will all have the “Test #” and “Step #” columns populated 

so that the system knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of test cases from a spreadsheet, then you need to either enter the test 

cases (including any test steps) into this specially formatted spreadsheet or cut and paste them in from 

another existing Excel sheet that you’ve been using to manage test cases previously. Then click [Export] 

and the new items will be added to your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 

Test # Stores the ID of the test case. Should be left blank for new items 

being added to SpiraTeam 

Test Case Name The name of the test case. This field supports indentation, so you 

need to use Excel’s ability to Indent text fields to indicate how the 

items in the test case hierarchy are organized 

Test Case Description The long description of the test case. If you want it formatted, you 

need to add HTML tags such as <b> for bold 

Priority The priority of the test case. It needs to be one of the values from 

the dropdown list. 

Owner The user that should listed as the test case’s owner. Needs to be 

the ID of the user (e.g. user US00005 would be entered as just 5) 

Row Type This is used to tell the Add-In what type of row this is. You should 

enter “FOLDER” if this row is a test folder, “TestCase” if it is a test 

case and “>TestStep” if it is a test step belonging to a test case. 

These values should be selected from the dropdown list. 

Note: You should make sure that test step rows are located directly 

underneath the test case they are a part of. 

Step # Stores the ID of the test step. Should be left blank for new test 

steps being added to a test case 

Test Step Description The description of the test step. This should contain the description 

of the actions that the tester needs to take. If you want it formatted, 

you need to add HTML tags such as <b> for bold 

Expected Result The expected result of the test step. This should contain the 

description of what the tester should see if the step succeeds. If you 

want it formatted, you need to add HTML tags such as <b> for bold 

Sample Data The sample date for the test step. This should contain any sample 

data that the tester can use when testing the step. If you want it 
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formatted, you need to add HTML tags such as <b> for bold 

MS-Excel 2003/2007 Add-In Specific Fields 

Requirement The requirement that this test case should be mapped to. Needs to be 

the ID of the requirement (e.g. requirement RQ00005 would be 

entered as just 5). Note that this field always appends, so if you want 

to add a test case to two requirements, run the export twice, once for 

each requirement. 

Note: This field only Exports to Spira and not the other way around 

Release The release that this test case should be mapped to. Needs to be the 

ID of the release (e.g. release RL00005 would be entered as just 5). 

Note that this field always appends, so if you want to add a test case to 

two releases, run the export twice, once for each release. 

Note: This field only Exports to Spira and not the other way around 

Test Set The test set that this test case should be added to. Needs to be the ID 

of the test set (e.g. test set TX00005 would be entered as just 5). Note 

that this field always appends, so if you want to add a test case to two 

test sets, run the export twice, once for each test set. 

Note: This field only Exports to Spira and not the other way around 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

MS-Excel 2010 Add-In Specific Fields 

Type The type of the test case. It needs to be one of the values from the 

dropdown list. 

Status The status of the test case. It needs to be one of the values from the 

dropdown list. 

Requirement The requirement(s) that this test case should be mapped to. Needs to 

be a comma-separated list of requirement IDs (e.g. requirements 

RQ00005 and RQ00008 would be entered as just “5,8”). 

Note: This field only Exports to Spira and not the other way around 

Release The release(s) that this test case should be mapped to. Needs to be a 

comma-separated list of release version numbers (e.g. releases 

1.1.0.0 and 1.2.0.0 would be entered as “1.1.0.0,1.2.0.0”). 

Note: This field only Exports to Spira and not the other way around 

Test Set The test set(s) that this test case should be added to. Needs to be a 

comma-separated list of test set IDs (e.g. test sets TX00005 and 

TX00008 would be entered as just “5,8”). 

Note: This field only Exports to Spira and not the other way around 

Components This should be a comma-separated list of the Name of the 

Components the test case is assigned-to. 

E.g. Component 1, Component 2 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value entered 

depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 

• MultiList – provide a comma-separated list of the numeric IDs 

of the custom list values (e.g. PV00005 and PV00003 would 

be entered as just “5,3”) 
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• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format (e.g. 

m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

 

Note: the columns that are required are listed in bold type. 

2.4.5 Importing/Exporting Incidents 

To import/export incidents, first you need to click on the “Incidents” tab in the Excel sheet: 

 

Next if you want to import the list of existing Incidents from SpiraTeam, you should click on the [Clear] 

icon to first remove the sample information from the spreadsheet, then click [Import] to load the list of 

existing incidents into the sheet. These items will all have the “Inc #” column populated so that the system 

knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of incidents from a spreadsheet, then you need to either enter the 

incidents into this specially formatted spreadsheet or cut and paste them in from another existing Excel 

sheet that you’ve been using to manage incidents previously. Then click [Export] and the new items will 

be added to your instance of SpiraTeam. 

The various columns that can be imported/exported, and the rules for entering data are listed below: 

Inc # Stores the ID of the incident. Should be left blank for new items 

being added to SpiraTeam 

Incident Name The name of the incident. 

Incident Description The long description of the incident. If you want it formatted, you 

need to add HTML tags such as <b> for bold 

Type The type of the incident. It needs to be one of the values from the 

dropdown list. 

Status The status of the incident. It needs to be one of the values from the 

dropdown list. 

Priority The priority of the incident. It needs to be one of the values from the 

dropdown list. 

Severity The severity of the incident. It needs to be one of the values from 

the dropdown list. 

Detector The user that found the incident. Needs to be the ID of the user 

(e.g. user US00005 would be entered as just 5). If left blank, it will 

default to the user logged in through the Add-In. 

Owner The user that the incident should be assigned to Needs to be the ID 

of the user (e.g. user US00005 would be entered as just 5) 

Detected Date The date that the incident was found. If this field is not populated, 

the current date is used instead 
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Closed Date The date that the incident was closed. Do not enter a value in this 

field if the incident is not in a closed status. 

MS-Excel 2003 Add-In Specific Fields 

% Complete The completion percentage of the incident 

Detected Release The release that this incident was found in. Needs to be the ID of 

the release (e.g. release RL00005 would be entered as just 5) 

Resolved Release The release that this incident is scheduled to be fixed in. Needs to 

be the ID of the release (e.g. release RL00005 would be entered as 

just 5) 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

Resolution The description of a resolution/comment that should be appended 

to the incident. If you want it formatted, you need to add HTML tags 

such as <b> for bold. Note that this field always appends, so if you 

want to add two comments, just enter the first value and click 

[Export], then replace it with the second value and click [Export] 

MS-Excel 2007 Add-In Specific Fields 

Detected Release The release that this incident was found in. Needs to be the ID of 

the release (e.g. release RL00005 would be entered as just 5) 

Resolved Release The release that this incident is scheduled to be fixed in. Needs to 

be the ID of the release (e.g. release RL00005 would be entered as 

just 5) 

Est. Effort The estimated effort associated with the task (entered as a whole 

number of minutes) 

Act. Effort The actual effort associated with the task (entered as a whole 

number of minutes) 

Rem. Effort The remaining effort associated with the task (entered as a whole 

number of minutes) 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

Resolution The description of a resolution/comment that should be appended 

to the incident. If you want it formatted, you need to add HTML tags 

such as <b> for bold. Note that this field always appends, so if you 

want to add two comments, just enter the first value and click 

[Export], then replace it with the second value and click [Export] 

MS-Excel 2010 Add-In Specific Fields 

Detected Release The release/iteration that this incident was found in. Needs to be 

the version number of the release (e.g. 1.0.1.1) 

Resolved Release The release/iteration that this is planned to be fixed in. Needs to be 

the version number of the release (e.g. 1.0.1.1) 

Components This should be a comma-separated list of the Name of the 

Components the incident is assigned-to. 

E.g. Component 1, Component 2 
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Est. Effort The estimated effort associated with the task (entered as a whole 

number of minutes) 

Act. Effort The actual effort associated with the task (entered as a whole 

number of minutes) 

Rem. Effort The remaining effort associated with the task (entered as a whole 

number of minutes) 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value 

entered depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 

• MultiList – provide a comma-separated list of the numeric 

IDs of the custom list values (e.g. PV00005 and PV00003 

would be entered as just “5,3”) 

• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format 

(e.g. m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

Comment The description of a comment that should be appended to the 

incident. If you want it formatted, you need to add HTML tags such 

as <b> for bold. Note that this field always appends, so if you want 

to add two comments, just enter the first value and click [Export], 

then replace it with the second value and click [Export] 

 

Note: the columns that are required are listed in bold type. 

2.4.6 Importing/Exporting Tasks 

To import/export tasks, first you need to click on the “Tasks” tab in the Excel sheet: 

 

Next if you want to import the list of existing Tasks from SpiraTeam, you should click on the [Clear] icon to 

first remove the sample information from the spreadsheet, then click [Import] to load the list of existing 

tasks into the sheet. These items will all have the “Inc #” column populated so that the system knows to 

update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of tasks from a spreadsheet, then you need to either enter the tasks into 

this specially formatted spreadsheet or cut and paste them in from another existing Excel sheet that 

you’ve been using to manage tasks previously. Then click [Export] and the new items will be added to 

your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 

Task # Stores the ID of the task. Should be left blank for new items being 

added to SpiraTeam 

Task Name The name of the task. 

Task Description The long description of the task. If you want it formatted, you need 
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to add HTML tags such as <b> for bold 

Status The status of the task. It needs to be one of the values from the 

dropdown list. 

Priority The priority of the task. It needs to be one of the values from the 

dropdown list. 

Requirement The requirement that this task should be associated with. Needs to 

be the ID of the requirement (e.g. requirement RQ00005 would be 

entered as just 5). 

Owner The user that the task should be assigned to Needs to be the ID of 

the user (e.g. user US00005 would be entered as just 5) 

Start Date The date that work on the task is scheduled to start 

End Date The date that work on the task is scheduled to end 

Est. Effort The estimated effort associated with the task (entered as a whole 

number of minutes) 

Act. Effort The actual effort associated with the task (entered as a whole 

number of minutes) 

MS-Excel 2003 Add-In Specific Fields 

% Complete The completion percentage of the task 

Release # The release/iteration that this task is scheduled for. Needs to be the 

ID of the release/iteration (e.g. release RL00005 would be entered 

as just 5). 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

MS-Excel 2007 Add-In Specific Fields 

Rem. Effort The remaining effort associated with the task (entered as a whole 

number of minutes) 

Release # The release/iteration that this task is scheduled for. Needs to be the 

ID of the release/iteration (e.g. release RL00005 would be entered 

as just 5). 

TEXT-01 – TEXT-10 The ten (10) custom text properties available in the project 

LIST-01 – LIST-10 The ten (10) drop-down list properties available in the project. You 

need to enter the ID value of the custom property not the display 

name. E.g. if you have a custom property with ID = PV00005 you 

would enter just 5 in these boxes. 

MS-Excel 2010 Add-In Specific Fields 

Type The type of the task. It needs to be one of the values from the 

dropdown list. 

Rem. Effort The remaining effort associated with the task (entered as a whole 

number of minutes) 

Release Version The release/iteration that this task is scheduled for. Needs to be the 

version number of the release (e.g. 1.0.1.1) 

CUS-01 – CUS-30 The thirty (30) custom fields defined in the project. The value 

entered depends on the type of custom property: 

• List – provide the numeric ID of the custom list value (e.g. 

PV00005 would be entered as just “5”) 
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• MultiList – provide a comma-separated list of the numeric 

IDs of the custom list values (e.g. PV00005 and PV00003 

would be entered as just “5,3”) 

• Text – enter the text, include HTML tags if rich-text 

• Decimal – enter the number (e.g. 1.0) 

• Integer – enter the number (e.g. 2) 

• Date – enter the number in the current local time format 

(e.g. m/d/yyyy for the US, d/m/yyyy for Europe) 

• User – enter the ID of the user 

• Boolean – Enter either “True” or “False” 

Comment The description of a comment that should be appended to the task. 

If you want it formatted, you need to add HTML tags such as <b> 

for bold. Note that this field always appends, so if you want to add 

two comments, just enter the first value and click [Export], then 

replace it with the second value and click [Export] 

 

Note: the columns that are required are listed in bold type. 

2.4.7 Execute Test Cases Offline 

As well as being able to import/export data, you can also use the import spreadsheet to execute test 

cases while disconnected from your network and then upload the results to SpiraTeam as a single batch. 

To do this, when connected to the network, connect to the server using the Add-In [Connect] icon, select 

the project and “Test Runs”, then click on the “Test Runs” in the spreadsheet: 

 

Now you should click on the [Import] button, and the Add-In will load the list of Test Cases (and in the 

case of the MS-Office 2007/2010 Add-Ins, any Test Sets as well) that are currently assigned to you 

together with open cells (marked in green) that you can use to record the actual results of testing: 

 

You can now disconnect from the network and perform the testing activities offline. Enter the following 

entries into the spreadsheet: 

Status The execution status of that test step. It should be selected drop the 

dropdown list. The allowed values are: Failed / Passed / Blocked / 

Caution. 

Actual Result The long description of the actual result experienced during testing. 

If you want it formatted, you need to add HTML tags such as <b> 

for bold 
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Incident Name If you want to log an incident associated with the test failure, enter 

the name of the incident here. The description of the incident will be 

pre-populated with the Test Step Description, Expected Result, and 

Actual Result. 

 

Once you have finished testing and are connected back on the network, just click on the [Connect] icon to 

have the Add-In connect with the SpiraTeam server, choose the project name and “Test Runs” and then 

click [Export]. The test results will now be uploaded to the server. 

Note: If you are using the MS-Excel 2007/2010 Add-Ins, you will also see the Test Set ID, Release ID and 

TX TC ID (Test-Set, Test Case unique ID). You can manually set a Release ID on test cases that were 

not part of a test set. 

2.4.8 Importing Custom Property List Values 

To import/export custom property values (for list custom properties), first you need to click on the “Custom 

Values” tab in the Excel sheet: 

 

Next if you want to import the list of existing custom list values from SpiraTeam, you should click on the 

[Clear] icon to first remove the sample information from the spreadsheet, then click [Import] to load the list 

of existing custom list values into the sheet. These items will all have the “Value #” column populated so 

that the system knows to update them rather than insert them when you subsequently click [Export]. 

If you want to simply export a list of custom list values from a spreadsheet, then you need to either enter 

the custom list ID and value name into this specially formatted spreadsheet or cut and paste them in from 

another existing Excel sheet that you’ve been using to manage the values previously. Then click [Export] 

and the new items will be added to your instance of SpiraTeam. 

The various columns that can be imported, and the rules for entering data are listed below: 

Field name Description 

Value # Stores the ID of the custom list value. Should be left blank for new 

items being added to SpiraTeam 

Custom List # The ID of the custom list that the value is being added to (with the CL 

prefix removed). For example custom list CL00005 would be entered 

as just “5” 

Custom Value Name The name of the custom value that you are inserting/updating in 

SpiraTeam 

Note: the columns that are required are listed in bold type. 
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2.5 Changing the Import/Export Options 

In the MS-Excel 2007 and 2010 Add-Ins, you can change how the import/export works by clicking on the 

Options icon. This brings up the Options dialog box: 

 

2.5.1 Rich Text Setting 

When you import artifacts from SpiraTeam into MS-Excel, if they have a formatted description, by default 

all the HTML tags that are used to describe the formatting will be loaded into the Excel cell. This is useful 

if you plan on making changes and then updating SpiraTeam (since it will preserve the formatting). 

However if you want to be able to more easily read the descriptions in Excel and do not plan on updating 

SpiraTeam, you can select the option to Remove the Formatting, which will convert the descriptions to 

plain-text before loading them into Excel. 

2.5.2 Test Run Date Setting 

If you set a date for the ‘Test Run Date’, the importer will use that date to be the date the test runs were 

executed on, rather than the current date/time, which is used by default. 
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3 Importing from Microsoft Excel (Office365) 

If you are using Office365 in the cloud (via a web browser) or if you are using Microsoft Office 2016+, you 

can use the dedicated Office365 Microsoft Excel add-in. 

 

3.1 Installation 

To install the add-in, go to the insert tab in Excel. Click on “Office Add-Ins” and in the window that 

opens navigate to the store tab. Enter “SpiraTeam Excel 365 Integration” into the search bar and 

search. When you see the correct add-in developed by Inflectra, click on the “Add” button associated with 

it. You should now see the SpiraTeam icon labeled “Show add-in” in your home tab. Click on it to begin. 

 

3.2 The Template 

Downloading and Applying: 

When you first open the add-in, you should see the following in your welcome screen: 

Click on the “Download Template” button to begin the download.  If you are using a desktop version of 

Excel open the file as you would any other workbook.  
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If you are using Excel Online, you will need to upload the file to your OneDrive. You can get to OneDrive 

quickly by clicking on the menu icon in the top left corner of Excel Online and selecting OneDrive. 

You should now see the following in your Excel Window: 

 

At this point please click on “File” and “Save As”. Create a new copy of the template and name it 

after the project you plan on working on. Remember to do this before making any changes to the 

template or logging in to avoid overwriting your original template. 

For a full description list of the template fields, please refer to the table in section 1.3.2. The only 

differences are the (temporary) exclusion of the linked requirements and comments fields, as well as the 

30 “CUS-01” style custom fields. This add-in will load your custom field names dynamically. To do this, 

you must now log in. 

 

3.3 Connecting to SpiraTeam 

Once the template is loaded, click on the SpiraExcel add-in ribbon icon to show the exporter and fill in the 
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following fields: 

o Your Team’s Spira Url: The web address that you use to access SpiraTeam® in your browser. 

This is usually in the form https://<hostname>/SpiraTeam.com. Make sure to remove any 

suffixes from the address (e.g. /Default/aspx). The url must be an https address, if your url does 

not begin with https:// it will not work. 

o Your Username: The username that you use for logging in to SpiraTeam 

o Your API key: The API key associated with your SpiraTeam account 

 

You will be notified if there is an issue with your url or the user information you provided. If your log in is 

successful, you will see the following screen where you can select a SpiraTeam project to load 

information from: 

  

 

Select a project and an artifact to populate the fields in the template that have drop down lists associated 

with them (e.g. users, releases, components, etc.) and populate the list of custom fields associated with 

the project. You are now ready to begin creating requirements. 

 

3.4 Creating Requirements 

After you have selected your project and an artifact (currently only requirements are available) You may 

start filling out your worksheet. The ID # field should be left empty for new requirements. If the field is not 

empty the row will be ignored. This is to avoid affecting any existing requirements. 

Custom Fields: If you have selected your project and artifact type, you should see the custom fields 

associated with your project in the custom fields section of the template (it will be empty if your project 

has no custom fields for requirements). You must know what data the custom field will accept. For a list 

of acceptable data types for different fields, refer to the template field chart in section 1.3.2. 
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Indenting and Hierarchy: Indents are handled with a “>” symbol. The farther in a requirement needs to 

be indented, the more “>” symbols are required. The first requirement will always be at the root level. For 

an example of this, refer to the values in the template: 

 

If you were to send these new requirements to your existing project, they would show up in SpiraTeam 

like this: 

Event Log: When requirements are sending, you will see a loading spinner and a log of progress that 

looks like this: 

Here is a list of possible messages: 

(Requirement name) sent successfully: The requirement in line was successfully created in SpiraTeam 

(Requirement name) failed to send: The requirement could not be created in SpiraTeam. May be 

missing a required field. Check console for response from API. 

(Requirement ID) was not updated: The requirement had a value in its ID field and was ignored. If it 

was intended to be a new requirement, please clear the ID field and try again. 

Done!: All requirements in queue have either been created, rejected, or ignored. 

When requirements are sent successfully their ID field will be filled out with the new ID created in 

SpiraTeam. 

To clear the event log, click on Clear Log. 
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3.5 Saving the Worksheet and Logging Out 

Make sure you had previously created a new file by selecting Save As so you don’t overwrite your 

template. Name the worksheet the same as your project so it is easy to keep organized. Excel will then 

either auto save any changes you make or you can save the worksheet the same as any other worksheet 

in Excel. 

When you have finished sending requirements to SpiraTeam, click on Log Out to disconnect and return 

to the log in screen. 
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4 Importing from Google Sheets 

The web-based interface of SpiraTeam® is ideal for creating and managing all aspects of your projects. 

However when migrating requirements, release, tasks, and test cases with test steps for an existing 

project from another system, it is useful to be able to load in a batch of artifacts, rather than having to 

manually enter them one at a time. 

To simplify this task we’ve created a Google sheets add-on for SpiraTeam® that can import requirements, 

releases, tasks, and test cases with test steps from a generated spreadsheet into SpiraTeam®. 

*This guide assumes you have a Google account with access to Google Drive and persistent access to 

the internet. It also assumes your instance of SpiraTeam (or SpiraTest, or SpiraPlan) is accessible over 

the internet so that Google Sheets can send data to it. 

4.1 Installing the SpiraTeam® Google Sheets Integration Add-on 

Like most Google services installation is very simple and straightforward as long as you have a Google 

account.   

1. Open a new spreadsheet, navigate to the add-on menu, and click the “Get add-ons” option. 

 

 

 

 

 

 

2. From there the Add-on store will launch, simply search for “SpiraTeam” and you will find the 

SpiraTeam Import Tool Add-on. 

3. Click install and authorize the add-on to work with documents related to your account. 

 

4.2 Connecting to SpiraTeam® 

Before connecting to SpiraTeam® with the add-on make sure that you’re working on the first tab in the 

spreadsheet. 

1. Launch the add-on from the add-on menu with the “Start” option. The add-on will launch into a 

window docked to the side of your current spreadsheet. 
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2. When the add-on fully loads you will be able to enter your SpiraTeam® log in credentials. 

 

• Spira URL : Please enter the web address that you use to access SpiraTeam® in your browser. 

This is usually of the form http://<hostname>/SpiraTeam. Make sure that you remove any suffixes 

from the address (e.g. Default.aspx). 

• User Name : Please enter the username that you use when logging into SpiraTeam. 

• RSS Token : Please enter your RSS token including the curly braces i.e {ExampleRSS}.  

o To activate your RSS Token: 

▪ Click on the User Profile menu in the application header 

▪ Click on “My Profile” 

▪ The string of numbers including the brackets listed in the RSS Token text box is 

your token. 

▪ If you don't see an RSS Token in that box, then click on 'Enable RSS Feeds' so 

that it is checked. 

▪ Click the button 'Generate New' to get a new RSS token. 

▪ Click [Update] to save your changes 
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3. Once you have entered the necessary information, please click [ Log In ] to authenticate with the 

server. If the login information is invalid, you will see an error message appear, otherwise you will 

be connected and the list of projects and artifacts will be populated. 

 

4.3 Choosing the project and artifact 

 

 

Once you have successfully connected to SpiraTeam, you should now choose the appropriate Project 

and Artifact in the system to which you will be importing into SpiraTeam. As you make your selections 

more buttons will be enabled. Please note that there is currently no way to get data from SpiraTeam: this 

is planned for a future release. 

 

After the project and artifact have been selected you will be able to load the appropriate template onto the 

first sheet of your Google Sheets workbook. 

 

4.4 Loading your Template 

The SpiraTeam Google Sheets Integration add-on dynamically generates a template for each artifact with 

the click of a button. After a valid project and artifact have been selected the [ Load ] button will be 

enabled. Click this button to generate the required template. 

 

**Warning: make sure all data is saved before loading a template. 
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4.5 Filling in The Template 

The above template is for requirements. Fields which have list of values to select from have dropdowns to 

make choosing the right values easy. 

For an artifact to be created successfully in SpiraTeam it has to have certain fields filled in. These 

required fields are highlighted in bold black text. For example, the above screenshot is for requirements, 

where both the Name and Type field are required. 

Different artifacts have different factors to take account of when entering the data: 

• Requirements: SpiraTeam allows a hierarchy of requirements (where each requirement can 

have children, who can, in turn, have child requirements of their own). To designate the hierarchy 

level of requirements, use the “>” character. For example: 

o “Parent Requirement” 

o “> Child of Parent” 

o “> Another child of parent” 

o “>> Child of “Another Child”” 

o “A second parent requirement” 

• Releases: are also hierarchical, and this is set on the sheet in the same way as requirements 

• Test Cases with Test Steps: The screenshot below shows the basic template for Test Cases. 

Please note the following points: 

o A test step must have a test case parent to be linked to and all test steps below a test 

case will become the steps for that test case. 

o There is no need to number the test steps – SpiraTeam adds this information 

automatically 

o Because each row can either be a case or a step, there are columns for both – some are 

only for test cases, others are only for tests steps, and one field can be used by either 

o The lighter orange column names are ONLY for test step creation 

o Black and bold fields are required to create a test case (Test Case Name, Test Case 

Type, and Test Case Status) 
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o Black fields that are NOT bold are required fields for test steps (Test Case/Step 

Description, Test Step Expected Result) 

o If a row has a mix of required fields in, the addon won’t know if it is a test case or a test 

step, so it will flag this an error 

 

Below is a partially filled in test case with test steps template – it is visually easy to see which rows are 

steps to which case. However, on row 11 the Test Step Expected Result has been filled in, so should this 

be a step or a case? The addon will mark this as in error and won’t attempt to import it in SpiraTeam. 

  

 

4.6 Import Into SpiraTeam 

Before importing new artifacts, make sure that you’re on the first tab of your spreadsheet and the 

template is loaded, and the dropdowns in the sidebar show the correct project and artifact type. 

After the correct/required fields have been entered, click the [ Send to SpiraTeam ] button to send your 

data to SpiraTeam®. You will see a popup showing overall progress. 

When the artifact has been successfully created an ID number will be placed in the ID column. This is the 

ID straight from SpiraTeam.  

If there are any errors for a particular row (eg if required fields have not all been filled in, or if there was 

some other problem with the data or on the SpiraTeam server) that row will be highlighted with a 

comment in column A explain the problem.  

For hierarchical artifacts (ones with parents and children), the import process will stop as soon as any 

error is found, to ensure SpiraTeam does not create an incorrect hierarchy  
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5 Importing from Microsoft Word 

The web-based interface of SpiraTeam® is ideal for creating and managing requirements, test cases and 

incidents for a new project. However often an organization will often have existing requirements 

documentation and test case templates in Microsoft Word format that need to get easily migrated into 

SpiraTeam. 

To simplify this task, SpiraTeam® comes with a Microsoft Word Add-In that can export requirements and 

test cases from a populated Word document into SpiraTeam®. Note that this guide refers to SpiraTeam®, 

but the Word Add-In can be used with SpiraTest® and SpiraPlan® as well. The only difference is that the 

Test Case import functionality will not be applicable for SpiraPlan® users. 

5.1 10Installing the Microsoft Word Add-In 

The first thing you need to do is to go to the “Add-Ons and Downloads” page of the Inflectra Website (it 

can be found in the SpiraTest, SpiraPlan or SpiraTeam sections), and download the MS-Office Add-Ins 

installation package. There are separate packages for the following versions of MS Office: 

 MS-Office 2003 Add-Ins – these are compatible with Microsoft Office 2003 and 2007. They can 

connect to SpiraTeam v2.3 or later. They also require Microsoft .NET 3.5. 

 MS-Office 2007 Add-Ins – these are compatible with Microsoft Office 2007 and 2010. They can 

connect to SpiraTeam v3.0 or later. They also require Microsoft .NET 4.0. 

 MS-Office 2010 Add-Ins – these are compatible with Microsoft Office 2010 and later. They can 

connect to SpiraTeam v5.0 or later. They also require Microsoft .NET 4.0. 

This installation package will install the add-ins for Microsoft Excel, Word and Project at the same time. If 

you don’t have the correct version of Microsoft .NET installed or some of the necessary prerequisites, you 

will be given the opportunity to install them when you first run the installation package. 

Once you have the Word Add-In installed, the second thing you’ll need to download is the 

SampleWordDocument document. This sample document contains some example requirements and 

test cases that be exported into SpiraTeam. Also the documents make good templates if you’re looking 

for a way to standardize the import of requirements and test cases. There are two versions of the 

document available - SampleWordDocument.doc for Word 2003 and SampleWordDocument.docx for 

Word 2007 and later. 

Once you have downloaded the template, please double-click on it to open it up in MS-Word. You will 

notice that there is an additional toolbar displayed in Word which is used for exporting requirements and 

test cases to SpiraTeam: 

 

If you are using the MS-Word 2007 or 2010 Add-In, you will see a modified version of the toolbar that 

makes use of the MS-Office Ribbon: 

 

This toolbar allows you to connect to SpiraTeam, and perform the export. The process for using this 

toolbar is described below: 
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5.2 Connecting to SpiraTeam® 

The first thing you need to do is to click on the [Connect] button to specify the information used to connect 

to your instance of SpiraTeam: 

 

Please enter the following information into the dialog box: 

o Spira URL: Please enter the web address that you use to access SpiraTeam® in your browser. This 

is usually of the form http://<hostname>/SpiraTeam. Make sure that you remove any suffixes 

from the address (e.g. Default.aspx). 

o User Name: Please enter the username that you use for logging in to SpiraTeam 

o Password: Please enter the password that you use for logging in to SpiraTeam 

o Remember Password: If you are using this Add-In on a private computer, you can check this option 

to have the system remember your credentials locally. Please do not use this option on a public 

computer and it will compromise the security of your SpiraTeam installation. 

Once you have entered the necessary information, please click [Connect] to authenticate with the server. 

If the login information is invalid, you will see an error message appear, otherwise you will be connected 

and the list of projects and artifacts will be populated. If you want to end your session, you should just 

click the [Disconnect] button and the Add-In will close your connection. 

5.3 Choosing the Project and Artifact 

Once you have successfully connected to SpiraTeam, you should now choose the appropriate Project 

and Artifact in the system that you will be importing / exporting: 

 

Or 

 

Once you have selected the project and artifact, there are two buttons that you can now use: 
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o Export: Clicking this button will take the currently selected data in the document and use it to add 

new items in SpiraTeam. 

o Style Mappings: This button allows you to change the parameters used by the Add-In when 

scanning the Word document to know where each requirement, test case and test step beings and 

ends. 

The parameters selection varies by the type of information being exported, and will be discussed in the 

relevant artifact section below: 

5.4 Exporting Requirements into SpiraTeam 

To export requirements, first you need to open up the MS-Word document that contains the requirements 

to be exported. Then you need to click on the “Style Mappings” icon to display the style mapping 

configuration dialog box: 

 

This dialog box allows you to tell the Add-In which styles are being used in the document to describe 

each level of Requirements in the hierarchy. When you run the Export, the Add-In will examine each 

paragraph in the document, and any item that matches one of these styles will be considered the start of 

a new requirement, and its indentation level will be based on the appropriate style. 

Once you have verified that the styles match those used in your document, highlight the areas of the 

document that you wish to import and click the [Import] button. Once you have done this, the Add-In will 

scan the selected portions of the document and export the requirements into the system. During the 

export, the Add-In uses the following rules for dealing with the content: 

o The text that matches the selected style will be loaded as the Name field of the requirement 

o Any text located between the selected styles will be loaded into the Description field of the 

requirement. The Add-In will attempt to match the formatted used in the Word document. However 

because of some differences between MS-Word and HTML, it may not be exact. 

o Any embedded images will be added to the requirement as a file Attachment, with an embedded 

image tag added to Description field 
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5.5 Exporting Test Cases into SpiraTeam 

To export test cases (and their test steps), first you need to open up the MS-Word document that contains 

the test cases to be exported. Then you need to click on the “Style Mappings” icon to display the style 

mapping configuration dialog box: 

 

This dialog box allows you to tell the Add-In which styles are being used in the document to denote the 

name of the Test Folder and the name of the Test Case. For the test steps, the Add-In currently requires 

that they be organized in tables, with each column in the table being used consistently to describe one of 

the three Test Step fields. For the import to work correct, your tables need to have at least three (3) 

columns so that it can map them correctly. You can use the same column multiple times (e.g. the 

contents of column 2 would be imported into both the expected result and sample data). 

Once you have verified that the styles and table columns match those used in your document, highlight 

the areas of the document that you wish to import and click the [Import] button. Once you have done this, 

the Add-In will scan the selected portions of the document and export the test cases and test steps into 

the system. During the export, the Add-In uses the following rules for dealing with the content: 

o The text that matches the selected style will be loaded as the Name field of the Test Folder or Test 

Case 

o Any text located between the selected styles will be loaded into the Description field of the Test Case. 

The Add-In will attempt to match the formatted used in the Word document. However because of 

some differences between MS-Word and HTML, it may not be exact. 

o Any embedded images will be added to the Test Case as a file Attachment, with an embedded image 

tag added to Description field 

o Any tables located between the selected styles will be treated as the Test Steps belonging to the 

previous test case. The fields for the Test Steps will be populated based on the index of the column. 

o Any text located in the table cells into the appropriate field of the Test Step. The Add-In will attempt to 

match the formatted used in the Word document. However because of some differences between 

MS-Word and HTML, it may not be exact. 

o The first row of the table is assumed to be a header row, so if you are seeing the first step of your 

document being omitted, it means that you need to add a header rows. 
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5.6 Error Reporting 

If there is an error during the import of either requirements or test cases, the error message will be stored 

in a text file called Spira_WordImport.log that can be found on the desktop of the user running the 

import: 
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6 Importing from Microsoft Project 

The web-based interface of SpiraTeam® is ideal for creating and managing requirements, 

releases/iterations and tasks for a new project. However when migrating requirements and tasks from an 

existing project, it is useful to be able to load in an existing project plan in batch and have SpiraTeam be 

able to interpret the data. 

To simplify this task, SpiraTeam® comes with a Microsoft Project Add-In that can export requirements, 

releases and tasks from a populated MS-Project plan into SpiraTeam®. In addition, the Add-In allows you 

to import those same artifacts back into the MS-Project plan to make batch updates which can then be 

used to update the master copies on the server. 

Note that this guide refers to SpiraTeam®, but the MS-Project Add-In can be used with SpiraPlan® as 

well. 

6.1 Installing the Microsoft Project Add-In 

The first thing you need to do is to go to the “Add-Ons and Downloads” page of the Inflectra Website (it 

can be found in the SpiraPlan or SpiraTeam sections), and download the MS-Office Add-Ins installation 

package. There are separate packages for the following versions of MS Office: 

 MS-Office 2003 Add-Ins – these are compatible with Microsoft Office 2003 and 2007. They can 

connect to SpiraTeam v2.3 or later. They also require Microsoft .NET 3.5. 

 MS-Office 2007 Add-Ins – these are compatible with Microsoft Office 2007 and 2010. They can 

connect to SpiraTeam v3.0 or later. They also require Microsoft .NET 4.0. 

 MS-Office 2010 Add-Ins – these are compatible with Microsoft Office 2010 and all later versions. 

They can connect to SpiraTeam v5.0 or later. They also require Microsoft .NET 4.0. 

This installation package will install the add-ins for Microsoft Excel, Word and Project at the same time. If 

you don’t have the correct version of Microsoft .NET installed or some of the necessary prerequisites, you 

will be given the opportunity to install them when you first run the installation package. 

Once you have the MS-Project Add-In installed, the second thing you may want to download is the 

SampleProjectFile.mpp MS-Project plan. This project file contains a fully-populated project plan and is a 

good sample to test the import/export before using a real project plan. 

Once you have downloaded the project file, please double-click on it to open it up in MS-Project. You will 

notice that there is an additional toolbar displayed in MS-Project which is used for importing/exporting 

data to/from SpiraTeam: 

 

If you are using the MS-Project 2010 Add-In, you will see a modified version of the toolbar that makes use 

of the MS-Office Ribbon: 

 

This toolbar allows you to connect to SpiraTeam, and perform the import/export. The process for using 

this toolbar is described below: 
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6.2 Connecting to SpiraTeam® 

The first thing you need to do is to click on the [Connect] button to specify the information used to connect 

to your instance of SpiraTeam: 

 

Please enter the following information into the dialog box: 

o Spira URL: Please enter the web address that you use to access SpiraTeam® in your browser. This 

is usually of the form http://<hostname>/SpiraTeam. Make sure that you remove any suffixes 

from the address (e.g. Default.aspx). 

o User Name: Please enter the username that you use for logging in to SpiraTeam 

o Password: Please enter the password that you use for logging in to SpiraTeam 

o Remember Password: If you are using this Add-In on a private computer, you can check this option 

to have the system remember your credentials locally. Please do not use this option on a public 

computer and it will compromise the security of your SpiraTeam installation. 

Once you have entered the necessary information, please click [Connect] to authenticate with the server. 

If the login information is invalid, you will see an error message appear, otherwise you will be connected 

and the list of projects and artifacts will be populated. If you want to end your session, you should just 

click the [Disconnect] button and the Add-In will close your connection. 

6.3 Choosing the Project 

Once you have successfully connected to SpiraTeam, you should now choose the appropriate Project in 

the system that you will be importing / exporting to / from: 

 

Or 

 

Once you have selected the project, there are three buttons that you can now use: 
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o Import: Clicking this button will retrieve the data from the SpiraTeam server and use that to populate 

the MS-Project file. 

o Export: Clicking this button will take the data in the currently opened MS-Project file and use it to 

add/update items in SpiraTeam. 

o Clear: This button allows you to quickly clear the data in the current Project file so that you can import 

a clean version from the server. 

6.4 Importing/Exporting Data 

The MS-Project Add-In is capable of either importing data from SpiraTeam into the project file or 

exporting data from the project file to SpiraTeam. However it is important to understand how the system 

knows whether to add new items to SpiraTeam or whether to update existing items: 

o If you start with a blank MS-Project file and enter tasks into it, they will not have a value set on their 

Text1 custom field. When you perform an Export, it will add these as new items in SpiraTeam 

o If you start with a blank import MS-Project file and choose to Import data from SpiraTeam, those 

tasks imported will include the ID of the item in SpiraTeam as their Text1 custom field. You can either 

update those tasks or add new tasks in between. Any tasks that have the Text1 custom property 

populated will be updated in SpiraTeam when you choose Export, whereas any newly added tasks 

will be inserted in SpiraTeam. 

6.4.1 Importing from SpiraTeam 

The Add-In will import the tasks from SpiraTeam into the MS-Project file based on the following rules: 

o Any Releases/Iterations in SpiraTeam will be added as zero-effort (milestone) tasks in the MS-Project 

plan. 

o Any Requirements in SpiraTeam that have at least one task under them, will be added as summary 

tasks in the MS-Project plan. Their indentation in the project plan will match the requirements’ 

indentation in SpiraTeam 

o Any Tasks in SpiraTeam will be added as tasks in the MS-Project plan. The tasks will be nested 

directly under their parent requirement’s equivalent task in MS-Project. 

o Any Requirements in SpiraTeam that have no tasks under them, will be added as zero-effort 

(milestone) tasks in the MS-Project plan. Their indentation in the project plan will match the 

requirements’ indentation in SpiraTeam 

6.4.2 Exporting to SpiraTeam 

The Add-In will export the tasks in the MS-Project file into SpiraTeam based on the following rules: 

o Any summary tasks or top-level tasks in the MS-Project file will be treated as Requirements when 

being exported to SpiraTeam. 

o Any non-summary tasks that have zero-effort (milestones) that are not originally Releases/Iterations 

will be treated as Requirements when being exported to SpiraTeam. 

o Any non-summary tasks that are NOT at the top-level will be treated as Tasks when being exported 

to SpiraTeam. They will be attached to the requirement that is their parent task in MS-Project. 

o The export function does not update any of the Release/Iteration items. They need to be updated in 

SpiraTeam. 

o If you want to prevent an MS-Project Task from being imported into SpiraTeam simply set the value 

of its Text1 column to the text “IGNORE” (without the quotes). 
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Be careful when you indent/outdent a task in MS-Project. If you take a non-summary item (which would 

be represented by a Task in SpiraTeam) and make it a summary item by adding child tasks, when you 

next run Export, it will get added as a new Requirement in SpiraTeam, with the child tasks added as 

Tasks. The old task will still remain in SpiraTeam and will need to be manually removed. 
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7 Migrating from HP QualityCenter 

This section outlines how to use the included Migration Tool for importing Requirements, Test  Cases, 

Test Runs and Incidents from HP QualityCenter (formerly known as Mercury TestDirector). 

7.1 Installing the QualityCenter Migration Tool 

This section outlines how to install the migration tool for QualityCenter onto a workstation so that you can 

then migrate whole projects from QualityCenter to SpiraTest. It assumes that you already have a working 

installation of SpiraTest v3.0 or later. If you have an earlier version of SpiraTest you will need to upgrade 

to at least v3.0 before trying to migrate projects. 

The Windows installation package can be downloaded from the ‘Add-Ons & Downloads” section of the 

Inflectra website. Once you have obtained the Windows Installer package, simply double-click on the 

package to begin the installation wizard which should display the following welcome page: 

 

Click the <Next> button, accept the software license, then click <Next> again to choose the folder to 

install the migration tool to: 
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Choose the folder to install to, and then decide whether the application should be accessible by all users 

on the workstation or just the current user. Then click the <Install> button to start the installation process. 

It will confirm if you want to proceed, click <Next> then wait for it to finish. 

7.2 Using the HP QualityCenter Migration Tool 

Now that you have installed the migration tool, you can launch it at any time by going to Start > Programs 

> SpiraTest > Tools > QualityCenter Importer. This will launch the migration tool application itself: 

 

The first thing you need to do is to enter the URL for the instance of HP QualityCenter that you want to 

import the information from (typically of the form http://<server name>/qcbin) together with a valid 

username and password. 

Note that the importer has only been tested against version 9.0 of Quality Center or later. It may not work 

correctly against previous versions. Once you have entered this information, click the <Authenticate> 

button and the list of possible domains and projects will be populated. 

Select the QualityCenter domain and project that you want to import from and click the <Login> button: 

 

Assuming that the user name selected has permission to access this project, you will be prompted with a 

message box indicating that the login was successful. Now choose the types of artifact you want to import 

and then click the <Next> button to move to the next page in the import wizard: 
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This page allows you to enter the URL, user name and password that you want to use to access the 

instance of SpiraTest that you want to import to and click <Login>. Typically the URL is of the form 

(http://<server name>/SpiraTest). The version of the importer being used must be compatible 

with the version of SpiraTest you’re importing into; if not you will receive an error message. 

Assuming that the login was successful, click the <Start Import> button to actually begin the process of 

importing the various artifacts from QualityCenter into SpiraTest. Note that the importer will automatically 

create a new project in SpiraTest to hold all the artifacts with the same name as that used in 

QualityCenter. 

 

During the import process, as each of the types of artifact are imported, the progress display will change 

(as illustrated above). Once the import has finished, you will receive a message to that effect and the 

<Done> button will be enabled. Clicking this button closed the importer. You should now log into 

SpiraTest using the same user name and password that was used for the import to view the imported 

project. 

The migration tool will import the following artifacts: 

 Users (but not their roles and permissions) 

 Requirements 

 Test Cases and their associated manual design steps (but not any automated test scripts) 

 Test Runs and their associated manual test steps 

 Test Sets and the association with the test cases 
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 Defects, together with their associated lists of priorities and statuses 

 The coverage relationship between requirements and test cases 

 The linkages between any defects and test runs 

 The first ten (10) user-defined fields on each of the above artifact types. 

 Any attachments associated with the requirements, test cases, test sets or design steps. 

 

Note: Once you have migrated a project into SpiraTest you will have the definitions of incident priorities 

and statuses from both SpiraTest and QualityCenter (this is because QualityCenter doesn’t use the same 

codes as SpiraTest, so they will be imported). You should go back in to the Administration screen and 

make all the SpiraTest statuses and priorities inactive. 
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8 Project Backup and Migration 

This application allows an entire project to be exported to a backup file, for archiving and offline storage of 

SpiraTeam projects. The base minimum SpiraTeam version required is 3.2 (014), and there is some data 

that is not backed up, see the section 5.5 for details. Also there are separate versions of the backup and 

migration tool for SpiraTeam v3.2, v4.x and v5.x, and you need to use the appropriate version that 

matches your installations. 

The migration tool does not support upgrading versions, i.e. you need to have the same version of 

SpiraTeam for both the import and export phase. If you have two different versions of SpiraTeam, you 

must first upgrade the older installation to the same version as the newer one. 

8.1 Main Screen 

When running the application, you will see the main screen, which gives you three main options: Export, 

Import, and Transfer: 

 

8.2 Project Export 

Clicking the Export button will start the Export wizard, allowing you to save the project to a file. 
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On the first screen, enter in the SpiraTeam server URL, and the administrator account password. The 

administrator account must be used, so make sure that it is an active account (Active: Yes) in the 

application. When clicking the ‘Next’ button, it will verify the server and login information. 

The second screen gives you the selection of the project to export. Select the project, and then click the  

‘Next’ button. 

 

On the third screen, select the location and name of the file you wish to export the project to. If the file 

already exists, it will be overwritten. 

 

The next screen is the verification screen – make sure you wish to start the export, and then click the 

‘Next’ button. Once started, you cannot cancel or change any options. To change an option, click the 

‘Back’ button at any time before starting the process to go back a screen. 
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Once finished, your output file will be created. You can store and backup the file as you need. 

8.3 Project Import 

To import a project file into a new project in SpiraTeam, select the Import button on the main screen. This 

will start the Import wizard: 

 

On the first screen, enter in the SpiraTeam server URL, and the administrator account password. The 

administrator account must be used, so make sure that it is an active account (Active: Yes) in the 

application. When clicking the ‘Next’ button, it will verify the server and login information. 



 

 

Page 44 of 64 © Copyright 2006-2018, Inflectra Corporation This document contains Inflectra proprietary information 

 

The second screen allows you to enter in a name for the project created. You can enter in the name of an 

existing project, but a new project by that name will be created – it will not import the project into an 

existing project.  

The third screen is only present on the SpiraTeam v4.0 version of the migration tool. This is because the 

SpiraTeam 4.0 API requires that new user’s be created with passwords of specific strength. Any user in 

the project file that is not present in the destination system will be created with the password that you 

specify: 

 

You should enter a password, click the ‘Test’ button to make sure it will be accepted by SpiraTeam, and 

then click the ‘Next’ button. This will then display the fourth screen: 
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The fourth screen will let you select the PRJ Project file. Select the file by clicking on the folder button, 

and the application will verify the integrity of the file before performing the import: 

 

The last screen will let you verify your settings before starting the import. If any changes need to be 

made, click the Back button. Once ready to import the project, click the ‘Finish button to start the import. 

If any error occurs during import, it’s not recommended to use the project created in the application, 

although you can log in and view the data that was imported. 

8.4 Project Transfer 

Selecting the ‘Transfer’ button will start the transfer wizard, which contains screens from both the Import 

and Export wizards, above.  

The first two screens will let you select the SpiraTeam application to pull the project from, following the 

same information as the first two screens in the Export wizard. 

The next three screens will ask for the new SpiraTeam application to create the project in and the default 

password for any new users that need to be created. These three screens follow the first three screens of 

the Import wizard, above. Note that the application will try to determine if you’re trying to re-import the 

project into the same server, and advise that copying the project in the SpiraTeam UI is a better choice.  
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The final screen will provide a summary of the chosen settings. Once you click ‘Next’, the transfer process 

will start: 

 

Once transfer starts, the entire project will be unloaded into a temporary directory on the computer 

running the application, and then the project will be imported into the new system. 

8.5 Data Transferred 

 

Data SpiraTeam v3.2 

 Exported Imported 

Incidents   

Requirements   

Tasks   

Releases   

Test Cases   

Test Sets   

Test Runs   

Custom Properties   

Custom Lists   

Document Files   

Document Folders   

Document Types   

Comments / Resolutions   
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The table on the left shows what data is backed up 

and restored. Future versions of the Migration tool 

and SpiraTeam may support exporting and importing 

more data.  

The exported project file may be large, since the 

binary data of all the attachments are downloaded 

and contained within the file.  

Once an export is completed, the migration tool will 

not delete the project from the system – you must still do that through the UI. Any changes in the project 

will not automatically be updated in the export file; you must re-run the export. 

Notes: 

1Users imported back into v3.2 will be marked Active, even if they were originally inactive.4B 

Datasync Mappings   

Automation Hosts   

Automation Engines   

Project Roles   

Project Users  1 
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9 Migrating from MS Test Manager 

This section outlines how to use the free Migration Tool for importing users, test plans, test suites, test 

cases and test runs from Microsoft Test Manager (MTM) 2010 or later. 

9.1 Installing the MTM Migration Tool 

This section outlines how to install the migration tool for MTM onto a workstation so that you can then 

migrate whole projects from MTM into SpiraTest (or SpiraTeam). It assumes that you already have a 

working installation of SpiraTest v4.0 or later. If you have an earlier version of SpiraTest you will need to 

upgrade to at least v4.0 before trying to migrate projects. 

The Windows installation package can be downloaded from the ‘Add-Ons & Downloads” section of the 

Inflectra website. Once you have obtained the Windows Installer package, simply double-click on the 

package to begin the installation wizard which should display the following welcome page: 

 

Click the <Next> button, accept the software license, then click <Next> again to choose the folder to 

install the migration tool to: 
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Choose the folder to install to, and then decide whether the application should be accessible by all users 

on the workstation or just the current user. Then click the <Install> button to start the installation process. 

It will confirm if you want to proceed, click <Next> then wait for it to finish. 

9.2 Using the MTM Migration Tool 

Now that you have installed the migration tool, you can launch it at any time by going to Start > Programs 

> SpiraTest > Tools > MTM Importer. This will launch the migration tool application itself: 

 

The first thing you need to do is to enter the URL for the instance of Microsoft Team Foundation Server 

(TFS) that MTM is running on. The URL should include the project collection that you want to import the 

information from (typically of the form http://server:8080/tfs) together with a valid username, Windows® 

domain and password. 

Once you have entered this information, click the <Authenticate> button and the list of possible projects 

will be populated in the Project dropdown list. Select the MTM project that you want to import from and 

either keep the Test Plan dropdown set to ‘All Test Plans’ or pick a specific test plan to import. 

You can also at this point choose which optional items will be imported from MTM (users, test runs, 

attachments or test sets) – test cases are always imported. Once you have chosen the project and/or test 

plan, click the <Next> button to go to the SpiraTest configuration screen. 
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This page allows you to enter the URL, user name and password that you want to use to access the 

instance of SpiraTest that you want to import to and click <Login>. Typically the URL is of the form 

(http://<server name>/SpiraTest). The version of the importer being used must be compatible 

with the version of SpiraTest you’re importing into; if not you will receive an error message. 

Assuming that the login was successful, click the <Start Import> button to actually begin the process of 

importing the various artifacts from MTM into SpiraTest. Note that the importer will automatically create a 

new project in SpiraTest to hold all the artifacts with the same name as that used in MTM. 

 

During the import process, as each of the types of artifact are imported, the progress display will change 

(as illustrated above). Once the import has finished, you will receive a message to that effect and the 

<Done> button will be enabled. Clicking this button closed the importer. You should now log into 

SpiraTest using the same user name and password that was used for the import to view the imported 

project. 

The migration tool will import the following artifacts: 

 Users (but not their roles and permissions) 

 Test Plans and their associated Test Suites 

 Test Cases and their associated steps, including any shared test steps 

 Test Runs and their associated test results 

 Test Sets and the association with the test cases 

 Any attachments associated with the requirements, test cases, test sets or design steps. 
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10 Migrating from HP ALM 

This section outlines how to use the included Migration Tool for importing Releases, Hosts, 

Requirements, Test Cases, Test Runs and Incidents from HP ALM (formerly known as HP Quality 

Center). 

10.1 Installing the HP ALM Migration Tool 

This section outlines how to install the migration tool for HP ALM onto a workstation so that you can then 

migrate whole projects from HP ALM to either SpiraTest or SpiraTeam (hereafter referred to as 

SpiraTest). It assumes that you already have a working installation of SpiraTest v4.0 or later and a 

working version of HP ALM 11.5 or later. If you have an earlier version of SpiraTest you will need to 

upgrade to at least v4.0 before trying to migrate projects. If you are using HP QualityCenter 10.0 or older, 

please refer to the migration tool for this version in section 4 of this document. 

The Windows installation package can be downloaded from the ‘Add-Ons & Downloads” section of the 

Inflectra website. Once you have obtained the Windows Installer package, simply double-click on the 

package to begin the installation wizard which should display the following welcome page: 

 

Click the <Next> button, accept the software license, then click <Next> again to choose the folder to 

install the migration tool to: 
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Choose the folder to install to, and then decide whether the application should be accessible by all users 

on the workstation or just the current user. Then click the <Install> button to start the installation process. 

It will confirm if you want to proceed, click <Next> then wait for it to finish. 

10.2 Using the HP QualityCenter Migration Tool 

Now that you have installed the migration tool, you can launch it at any time by going to Start > Programs 

> Inflectra > SpiraTest > Tools > HP ALM Importer. This will launch the migration tool application itself: 

 

The first thing you need to do is to enter the URL for the instance of HP ALM that you want to import the 

information from (typically of the form http://<server name>/qcbin) together with a valid username 

and password. 

Once you have entered this information, click the <Authenticate> button and the list of possible domains 

and projects will be populated. Select the HP ALM domain and project that you want to import from and 

click the <Login> button. 

Assuming that the user name selected has permission to access this project, you will be prompted with a 

message box indicating that the login was successful. Now choose the types of artifact you want to import 

and then click the <Next> button to move to the next page in the import wizard: 
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This page allows you to enter the URL, user name and password that you want to use to access the 

instance of SpiraTest that you want to import to and click <Login>. Typically the URL is of the form 

(http://<server name>/SpiraTest). The version of the importer being used must be compatible 

with the version of SpiraTest you’re importing into; if not you will receive an error message. 

In addition, you need to enter the default password for all users that the importer will create in SpiraTest. 

You need to make sure that this password meets the minimum complexity requirements of your SpiraTest 

installation or the import will fail with an error message indicating the password is not allowed. 

Assuming that the login was successful, click the <Start Import> button to actually begin the process of 

importing the various artifacts from HP ALM into SpiraTest. Note that the importer will automatically 

create a new project in SpiraTest to hold all the artifacts with the same name as that used in HP ALM. 

 

During the import process, as each of the types of artifact are imported, the progress display will change 

(as illustrated above). Once the import has finished, you will receive a message to that effect and the 

<Done> button will be enabled. Clicking this button closed the importer. You should now log into 

SpiraTest using the same user name and password that was used for the import to view the imported 

project. 

The migration tool will import the following artifacts: 

 Custom Properties and Custom Lists 
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 Users (but not their roles and permissions) 

 Releases 

 Requirements 

 Automation Hosts 

 Test Cases and their associated manual design steps (but not any automated test scripts) 

 Test Runs and their associated manual test steps 

 Test Sets and the association with the test cases 

 Defects, together with their associated lists of priorities and statuses 

 The coverage relationship between requirements and test cases 

 The linkages between any defects and test runs 

 Any attachments associated with the requirements, test cases, test sets or design steps. 

 

Note: Once you have migrated a project into SpiraTest you will have the definitions of incident priorities 

and statuses from both SpiraTest and HP ALM (this is because HP ALM doesn’t use the same codes as 

SpiraTest, so they will be imported).  

You should go back in to the Administration screen and make all the standard SpiraTest statuses and 

priorities inactive, and then create a new incident workflow using the imported HP ALM statuses. 

 

11 Migrating from TestRail 

This section outlines how to use the free Migration Tool for importing Milestones, Test Cases, Test Suites, 

Test Plans, Test Runs, and Test Results from Gurock TestRail into SpiraTest. 

11.1 Installing the TestRail Migration Tool 

This section outlines how to install the migration tool for TestRail onto a workstation so that you can then 

migrate whole projects from TestRail to either SpiraTest or SpiraTeam (hereafter referred to as 

SpiraTest). It assumes that you already have a working installation of SpiraTest v5.0 or later and a live 

instance of TestRail to migrate from. If you have an earlier version of SpiraTest you will need to upgrade 

to at least v5.0 before trying to migrate projects. 

The Windows installation package can be downloaded from the ‘Add-Ons & Downloads” section of the 

Inflectra website. Once you have obtained the Windows Installer package, simply double-click on the 

package to begin the installation wizard which should display the following welcome page: 
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Click the <Next> button, accept the software license, then click <Next> again to choose the folder to 

install the migration tool to: 

 

Choose the folder to install to, and then decide whether the application should be accessible by all users 

on the workstation or just the current user. Then click the <Install> button to start the installation process. 

It will confirm if you want to proceed, click <Next> then wait for it to finish. 

11.2 Using the TestRail Migration Tool 

Now that you have installed the migration tool, you can launch it at any time by going to Start > Programs 

> Inflectra > SpiraTest > Tools > TestRail Importer. This will launch the migration tool application itself: 
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The first thing you need to do is to enter the URL for the instance of TestRail that you want to import the 

information from (typically of the form https://xxxxx.testrail.net) together with a valid username 

and password. 

Once you have entered this information, click the <Authenticate> button and the list of projects will be 

populated. Select TestRail project that you want to import from You can also choose to not import 

certain artifacts from TestRail (e.g. Milestones, etc.) then click the <Next> button to move to the next page 

in the import wizard: 

 

This page allows you to enter the URL, user name and password that you want to use to access the 

instance of SpiraTest that you want to import to and click <Login>. Typically, the URL is of the form 

(https://xxxx.spiraservice.net). The version of the importer being used must be compatible with 

the version of SpiraTest you’re importing into; if not you will receive an error message. 
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In addition, you need to enter the default password for all users that the importer will create in SpiraTest. 

You need to make sure that this password meets the minimum complexity requirements of your SpiraTest 

installation or the import will fail with an error message indicating the password is not allowed. 

Assuming that the login was successful, click the <Start Import> button to actually begin the process of 

importing the various artifacts from TestRail into SpiraTest. Note that the importer will automatically create 

a new project in SpiraTest to hold all the artifacts with the same name as that used in TestRail. 

 

During the import process, as each of the types of artifact are imported, the progress display will change 

(as illustrated above). Once the import has finished, you will receive a message to that effect and the 

<Done> button will be enabled. Clicking this button closed the importer. You should now log into 

SpiraTest using the same user name and password that was used for the import to view the imported 

project. 

The migration tool will import the following artifacts from TestRail: 

 The project name and description 

 Users (but not their roles and permissions) 

 Milestones 

 Test suites and their sections 

 Test cases with their steps (if defined) 

 Test plans with associated tests and test results 

 

Should the import fail for any reason, there will be a log file created on the Desktop of the person doing 

the import. The filename is usually: Spira_TestRail_Import.log. 

12 Migrating from TestLink 

This section outlines how to use the free Migration Tool for importing Projects, Test Suites, Test Cases, 

and Test Steps from the open source TestLink application into SpiraTest. 



 

 

Page 58 of 64 © Copyright 2006-2018, Inflectra Corporation This document contains Inflectra proprietary information 

12.1 Installing the TestLink Migration Tool 

This section outlines how to install the migration tool for TestLink onto a workstation so that you can then 

migrate whole projects from TestLink to either SpiraTest, SpiraTeam or SpiraPlan (hereafter referred to 

as SpiraTest). It assumes that you already have a working installation of SpiraTest v5.0 or later and a live 

instance of TestLink to migrate from. If you have an earlier version of SpiraTest you will need to upgrade 

to at least v5.0 before trying to migrate projects. 

The Windows installation package can be downloaded from the ‘Add-Ons & Downloads” section of the 

Inflectra website. Once you have obtained the Windows Installer package, simply double-click on the 

package to begin the installation wizard which should display the following welcome page: 

 

Click the <Next> button, accept the software license, then click <Next> again to choose the folder to 

install the migration tool to: 
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Choose the folder to install to, and then decide whether the application should be accessible by all users 

on the workstation or just the current user. Then click the <Install> button to start the installation process. 

It will confirm if you want to proceed, click <Next> then wait for it to finish. 

12.2 Using the TestLink Migration Tool 

Now that you have installed the migration tool, you can launch it at any time by going to Start > Programs 

> Inflectra > SpiraTest > Tools > TestLink Importer. This will launch the migration tool application itself: 

 

The first thing you need to do is to enter the URL for the instance of TestLink that you want to import the 

information from (typically of the form http://myserver/testlink) together with a valid API Key. If 

you don’t have an API Key, you need to first login to TestLink using your normal username and password, 

then generate an API on the user profile page: 
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Once you have entered this information, click the <Authenticate> button and the list of projects will be 

populated. Select TestLink project that you want to import from then click the <Next> button to move to 

the next page in the import wizard: 

 

This page allows you to enter the URL, user name and password that you want to use to access the 

instance of SpiraTest that you want to import to and click <Login>. Typically, the URL is of the form 

(https://xxxx.spiraservice.net). The version of the importer being used must be compatible with 

the version of SpiraTest you’re importing into; if not you will receive an error message. 

In addition, you need to enter the default password for all users that the importer will create in SpiraTest. 

You need to make sure that this password meets the minimum complexity requirements of your SpiraTest 

installation or the import will fail with an error message indicating the password is not allowed. 
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Assuming that the login was successful, click the <Start Import> button to actually begin the process of 

importing the various artifacts from TestLink into SpiraTest. Note that the importer will automatically 

create a new project in SpiraTest to hold all the artifacts with the same name as that used in TestLink. 

 

During the import process, as each of the types of artifact are imported, the progress display will change 

(as illustrated above). Once the import has finished, you will receive a message to that effect and the 

<Done> button will be enabled. Clicking this button closed the importer. You should now log into 

SpiraTest using the same user name and password that was used for the import to view the imported 

project. 

The migration tool will import the following artifacts from TestLink: 

 The project name and description 

 Test suites  

 Test cases with their steps (if defined) 

For example, the following TestLink project: 

 

Now looks like this in SpiraTest (v5.4): 
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Should the import fail for any reason, there will be a log file created on the Desktop of the person doing 

the import. The filename is usually: Spira_TestLink_Import.log. 
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13 Legal Notices 

This publication is provided as is without warranty of any kind, either express or implied, including, but not 

limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement. 

This publication could include technical inaccuracies or typographical errors. Changes are periodically 

added to the information contained herein; these changes will be incorporated in new editions of the 

publication. Inflectra Corporation may make improvements and/or changes in the product(s) and/or 

program(s) and/or service(s) described in this publication at any time. 

The sections in this guide that discuss internet web security are provided as suggestions and guidelines. 

Internet security is constantly evolving field, and our suggestions are no substitute for an up-to-date 

understanding of the vulnerabilities inherent in deploying internet or web applications, and Inflectra cannot 

be held liable for any losses due to breaches of security, compromise of data or other cyber-attacks that 

may result from following our recommendations. 

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra Corporation in 

the United States of America and other countries. Microsoft®, Windows®, Explorer® and Microsoft Project® 

are registered trademarks of Microsoft Corporation. All other trademarks and product names are property 

of their respective holders. 

Please send comments and questions to: 

Technical Publications 

Inflectra Corporation 

8121 Georgia Ave, Suite 504 

Silver Spring, MD 20910-4957 

U.S.A. 

6Hsupport@inflectra.com 
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